USER'S MANUAL
for the

NAVAL
INTERACTIVE
DATA
ANALYSIS
SYSTEM-CLIMATOLOGIES
(NIDAS-C) Version 2.0

Technical Note 01-97
1 December 1996

Prepared for: Naval Oceanographic Office (Code DOST)
Stennis Space Center, Mississippi 38529

Contract Numbers: NRL N00014-92-C-0032 Mod P00009
NASA NAS13-664 Delivery Order 82

Approved for public release; distribution is unlimited.
Mississippi State University Center for Air Sea Technology
Stennis Space Center, MS 38529-6000
USER'S MANUAL

FOR THE

NAVAL INTERACTIVE DATA ANALYSIS SYSTEM – CLIMATOLOGY (NIDAS–C)

NIDAS–C Version 2.0 (1 December 1996)

CONTRACT NO: NRL N00014–92–C–6032 Mod P00009
NASA NAS13–564 D.O. 82

Prepared for:

NAVAL OCEANOGRAPHIC OFFICE
CODE DOST
STENNIS SPACE CENTER, MS 39529

Prepared by:

Mississippi State University
Center for Air Sea Technology
Building 1103, Room 233
Stennis Space Center, MS 39529–6000
Acknowledgements

Special Note of Thanks: The Center for Air Sea Technology gratefully acknowledges the special attention, clear guidance and encouragement of Mr. Steve Haeger, Naval Oceanographic Office.

UNIX is a trademark of American Telephone and Telegraph (AT&T), Incorporated
SUN, SUNOS and SparcStation are trademarks of Sun Microsystems, Incorporated
Motif is a trademark of the Open Software Foundation
X-Windows is a trademark of the Massachusetts Institute of Technology
Oracle is a trademark of Oracle, Incorporated
ag/X Toolmaster is a trademark of UNIRAS, Incorporated

Contributors to the NIDAS-C Software User’s Manual are:

Mr. Clifton Abbott, Software Engineer/Project Manager
Mr. Vishnu Mohan Das, Consultant
# Table of Contents

1 INTRODUCTION ................................................................. 1
1.1 Scope .................................................................................. 1
   1.1.1 Identification .......................................................... 1
   1.1.2 System Overview ..................................................... 1
   1.1.3 Data Overview .......................................................... 2
   1.1.4 Functionality Overview ............................................. 2
   1.1.5 Support Overview ..................................................... 3
   1.1.6 Document Overview ................................................... 3
1.2 Conventions .......................................................................... 3
1.3 Referenced Documents ....................................................... 4

2 EXECUTION PROCEDURES ....................................................... 5
2.1 Initialization (Launching the Application) .................................. 5
2.2 Description of Display Windows ........................................... 5
   2.2.1 Top Level Window (NIDAS-C GUI 1) ............................ 5
   2.2.2 Main Window (NIDAS-C GUI 2) .................................... 6
      2.2.2.1 Main Chart ....................................................... 7
      2.2.2.2 Profile Composite Chart ..................................... 7
      2.2.2.3 Menu Bar ......................................................... 7
         2.2.2.3.1 The File Pulldown Menu ................................. 8
         2.2.2.3.2 The Tools Pulldown Menu .............................. 10
         2.2.2.3.3 The Help Pulldown Menu ............................... 12
      2.2.2.4 Remark ........................................................... 12
      2.2.2.5 Repaint ........................................................... 12
   2.2.3 Data Retrieval Module (DRM) ...................................... 12
      2.2.3.1 BATHY (Bathymetry) ........................................ 13
         2.2.3.1.1 Display ..................................................... 13
         2.2.3.1.2 Data ......................................................... 13
         2.2.3.1.3 Options ..................................................... 13
      2.2.3.2 COAST (Coastline) ............................................. 13
         2.2.3.2.1 Display ..................................................... 13
         2.2.3.2.2 Data ......................................................... 14
         2.2.3.2.3 Options ..................................................... 14
      2.2.3.3 MOODS ........................................................... 14
         2.2.3.3.1 Display ..................................................... 14
         2.2.3.3.2 Data ......................................................... 15
         2.2.3.3.3 Options ..................................................... 17
      2.2.3.4 AUX1/AUX2 ...................................................... 18
      2.2.3.5 GDEM ........................................................... 19
         2.2.3.5.1 Display ..................................................... 19
2.2.3.5.2 Data .................................................. 19
2.2.3.5.3 Options ............................................... 20
2.2.3.6 GRID1/GRID2 .............................................. 20
2.2.4 Data Interactive Module (DIM) ..................................... 20
2.2.4.1 Zoom ..................................................... 21
2.2.4.2 Polygon ................................................... 21
2.2.4.3 Polygon Options ............................................ 22
2.2.4.4 Profile Isolation ............................................. 22
2.2.4.4.1 Flagging .............................................. 23
2.2.4.4.2 Update Db ............................................. 24
2.2.4.4.3 Export ................................................ 24
2.2.4.4.4 Delete ................................................ 24
2.2.4.5 GRID (Interpolation) ......................................... 24
2.2.4.5.1 Charter ................................................ 24
2.2.4.5.2 Display ............................................... 25
2.2.4.5.3 Options ............................................... 25

3 ERROR MESSAGES ...................................................... 26
3.1 Starting NIDAS–C .................................................... 26
3.2 Reading Data ........................................................ 26
3.3 Polygon ............................................................ 27
3.4 Zoom .............................................................. 27
3.5 Export .............................................................. 27
3.6 Interpolation (Charter) ............................................. 27

4 NOTES ................................................................. 28
4.1 System Considerations ................................................. 28
4.2 System/Software Requirements ........................................ 28
4.3 Directory Map ..................................................... 29
4.4 Security ............................................................. 29

APPENDICES
A Glossary ............................................................. A1
B List of Acronyms ..................................................... B1
C NIDAS Installation Procedures ........................................ C1

LIST OF FIGURES
Figure 1. Top–level modular structure of the Navy Interactive Data Analysis
        System – Chiratology (NIDAS–C) .................................... 3
Figure 2. NIDAS–C “Top Level Window” display screen ...................... 6
Figure 3. NIDAS–C “Main Window” display screen ................................ 7
Figure 4. NIDAS–C “Main Window” menu headers and pulldown menu options ........ 8
Figure 5. The NIDAS-C "Axis Options" pop-up window ................................................................. 9
Figure 6. The Tools "Data Selection Status" pop-up window ........................................................... 10
Figure 7. The Tools "Export Data" pop-up window ........................................................................ 11
Figure 8. NIDAS-C Data Retrieval Module (DRM) and Data Interactive Module (DIM) display window ........................................................................................................ 12
Figure 9. DRM "Bathymetry Options" pop-up window ................................................................. 13
Figure 10. DRM "Coastline Data" pop-up window for the Coastline data type .......................... 14
Figure 11. DRM "Coastline Options" pop-up window for the Coastline data type .................. 14
Figure 12. DRM "Data Selection" pop-up window for the MOODS data type ......................... 16
Figure 13. DRM "Version Selection" pop-up window for selecting the dataset version .......... 16
Figure 14. DRM "Time Selection" pop-up window for setting MOODS date/time criteria .......... 17
Figure 15. DRM "MOODS Options" pop-up window for the MOODS data type ...................... 18
Figure 16. DRM "Profile Flags" pop-up window for the MOODS data type ................................ 18
Figure 17. DRM "Data Selection" pop-up window for the GDEM data type .......................... 19
Figure 18. DRM "GDEM Options" pop-up window for the GDEM data type ......................... 20
Figure 19. DIM "Zoom Options" pop-up window ........................................................................ 21
Figure 20. DIM "Polygon Options" pop-up window .................................................................... 22
Figure 21. DIM "Profile Isolation" pop-up window ...................................................................... 23
Figure 22. "Flag" options pop-up window for profile isolation .................................................... 23
Figure 23. "Export" options pop-up window for profile isolation ................................................ 24
Figure 24. DIM "Charter Data Type Selection" .......................................................................... 25
Figure 25. DIM "Charter Values" pop-up window ....................................................................... 25
Figure 26. DIM "Charter Contour Options" pop-up window ...................................................... 26
NIDAS–C User’s Manual

1 INTRODUCTION

1.1 SCOPE

1.1.1 Identification

Computer Software Configuration Item (CSCI): Naval Interactive Data Analysis System – Climatology (NIDAS–C)

Version: 2.0

Release Data: To be determined at a later date

Contract No: NRL N00014–92–C–6032 Mod P00009
NASA NAS13–564 D.O. 82

Contractor: Mississippi State University
Center for Air Sea Technology
J.H. Corbin, Director
Building 1103, Room 233
Stennis Space Center, MS 39529–6000
Telephone: (601) 688–2561
Facsimile: (601) 688–7100

Principal Investigator: Mr. Clifton Abbott
Mississippi State University
Center for Air Sea Technology
Building 1103, Room 233
Stennis Space Center, MS 39529–6000
Telephone: (601) 688–3085
Facsimile: (601) 688–7100

1.1.2 System Overview

The objective of the NIDAS project is to provide NAVOCEANO with an interactive overlay capability for several types of oceanographic, meteorological, and satellite derived data, and create 3–D gridded fields of temperature and salinity profiles constructed from a combination of "provened" data (user derived) and gridded data. NIDAS–C provides interactive blending and overlaying capabilities for a broad range of climatology data.
1.1.3 Data Overview

NIDAS–C operates using numerous oceanographic data categories stored in an installed version of the Naval Environmental Operational Nowcast System (NEONS), a relational database management system (rdbms) which employs the ORACLE proprietary rdbms engine. Data management, configuration, and control functions for the supporting rdbms are performed externally. NIDAS–C stores and retrieves data to/from the rdbms but exercises no direct internal control over the rdbms or its configuration. Data is also ingested into the rdbms, for use by NIDAS–C, by external data acquisition processes. The data categories employed by NIDAS–C are as follows:

- Bathymetry - ocean depth at 'x' minute resolution
- Coastline - vector coordinates of the shoreline at several different resolutions from the World Vector Shoreline (WVS) datasets
- GDEM, GRID1, GRID2 - gridded fields of temperature, salinity, and sound speed provided by NAVOCEANO
- MOODS, AUX1, AUX2 - oceanographic profiles of temperature, salinity, and sound speed versus depth stored in the formats prescribed by the Master Oceanographic Observation Data Set (MOODS)

1.1.4 Functionality Overview

In the MIL-STD 2167a terminology, NIDAS–C is a Computer Software Configuration Item (CSCI). It is composed of four Computer Software Components (CSC), through which the functionality of NIDAS–C is achieved. The CSC's are as follows:

- **Graphical User Interface 1 (GUI 1)** - incorporates window management, user interface and display functionality;
- **Graphical User Interface 2 (GUI 2)** - incorporates window management, user interface and display functionality;
- **Data Retrieval Module (DRM)** - provides functional data management using relational RDBMS technology; and
- **Data Interactive Module (DIM)** - incorporates data processing, application of interactive methods and algorithms to the data, and graphical (visualization) processing of the data.

NIDAS–C has one external interface; the User-GUI interface which includes two graphical user interfaces. The User-GUI interface supports 1) user control of NIDAS–C using interactive techniques and 2) response/feedback to the user in the form of data display (graphical or numerical) and status indicators.

Figure 1 illustrates the NIDAS–C Top Level module and external interface architecture. NIDAS–C is the Computer Software Configuration Item (CSCI). There are four Computer Software Components (CSC).
1.1.5 Support Overview

This manual is the main document for NIDAS–C user support. System specifications are described in the NIDAS–C design document. Other additional support is contained in documentation for integrated proprietary (commercial) software, such as Oracle, and non-developed (government provided) software, such as the Naval Environmental Operational Nowcast System (NEONS).

1.1.6 Document Overview

The purpose of this document is to describe the functionality of NIDAS–C and the techniques/procedures that users may employ in producing a useful oceanographic product using NIDAS–C. Appendix A contains a list of definitions used in this document. Appendix B contains a list acronyms. Appendix C contains a set of instructions on how to install NIDAS–C.

1.2 Conventions

To simplify and standardize the communication of procedural details to the user, this manual adopts the following conventions:

- **Mouse Button Convention**: Most "click" or "select" operations with the mouse use the left button. Unless otherwise specified, instructions to
“click” or “select” refer to the left mouse button. When a “click” or “select” using the middle or right mouse button is required, the specific mouse button will be indicated in the text; otherwise the left mouse button should be assumed.

- **Dragging the Mouse:** Dragging the mouse refers to clicking the left mouse button, moving the mouse across the screen, and then releasing the mouse button.

- **Non-interactive Textboxes:** Textboxes with a buff-colored background are non-interactive. They provide information only and cannot be modified by the user.

### 1.3 Referenced Documents

This user's manual either contains references to the following documents, or summarizes information contained in them appropriate for further reading.


1.3.3 Naval Research Laboratory Modification P00009 to Contract N00014–92–C–6032 dated 16 August 1994.

1.3.4 NASA NAS13–564 Delivery Order 82 dated 23 May 1996.

1.3.5 “Design Document and Database Specifications for the Naval Interactive Data Analysis System—Climatologic: (NIDAS—C), Version 2.0”, Technical Note 02–96, Mississippi State University, Center for Air Sea Technology, 30, September 1996.


2 EXECUTION PROCEDURES

2.1 Initialization (Launching the Application)

NIDAS observes the standard procedure for executing an application in the UNIX/X-Windows environment. At the UNIX command line prompt, enter nidas-c. When X-Windows initialization procedures are complete the NIDAS-C GUI 1 or "Top-Level Window" display will appear. If using "Toms Window Manager"- "twm", a window skeleton appears on screen which must be maneuvered to the desired position on the monitor screen with the mouse. If using "motif window manager"- "mwm", the position of the main display is predefined and appears without any further action after entering nidas-c from the keyboard. Other window managers may involve different user action before the "Top-Level Window" display appears.

2.2 Description of Display Windows

The screen displays of NIDAS-C are X-Windows client window objects. Window control adheres to X-Windows procedures. As illustrated in Figure 2, the Top Level Window consists of 1) Globe map, 2) Latitude / Longitude specification, 3) Menu bar, and 4) Title area. The design of the Main Window is subdivided into the following areas (as shown in Figure 3): 1) the title area, 2) the "Main Chart" which provides a geographical display, 3) the "Profile Chart" which displays the GDEM, GRID1, GRID2, MOODS, AUX1, and AUX2 profiles, 4) a pull-down menu bar containing various options for interacting with the "Main Chart" and "Profile Chart" windows, and 5) a "Remark" area which communicates important messages to the user. Figure 9 displays the DRM "Data Selection" window, and the DIM "Data Retrieval" window. The "Data Selection" window consists of "Options", "Data", and "Display" for each of the data types. The "Data Retrieval" window consists of the Zoom, Polygon, Polygon Options, and Grid areas.

2.2.1 Top Level Window (NIDAS-C GUI 1)

The NIDAS-C GUI 1 (see Figure 2) manages one of the links between the user and NIDAS-C. Through this GUI the user can specify the region of interest by dragging the mouse across the region of interest in the globe map. The GUI indicates the selected region by displaying a rectangle across the region and also displaying the latitude / longitude coordinates of the region in the "REGION COORDINATES" text area. From the "File" pulldown menu, the user can perform one of three operations: 1) bring up the Main Window GUI by selecting the "Nidas" button, 2) clear any region specified by selecting the "Reset" button, and 3) exit from the application by selecting the "Exit" button.
Figure 2. NIDAS–C “Top Level Window” display screen.

Any specified region can be zoomed by selecting the “ZOOM” button which produces a pop-up window containing the zoomed region. The user can further sub-select a region from the zoomed region by dragging the mouse across the region of interest. The pop-up window is closed when the middle mouse button is clicked while the mouse is in the pop-up window. The top level window GUI will be updated to reflect any region specified in the zoomed region.

By selecting the “Nidas” option from the “File” pulldown menu, the user can bring up the Main Window GUI (GUI 2). Selecting the “Nidas” option without a region being specified would result in an error message. By selecting the “Reset” option from the “File” pulldown menu, the Main Window is returned to its default state.

2.2.2 Main Window (NIDAS–C GUI 2)

The NIDAS–C Main Window GUI (GUI 2) manages the second link between the user and NIDAS–C. Through this GUI, the user exercises all available NIDAS–C control options. NIDAS–C provides pop-up windows for user interaction, as well as interactive functionality within the “Main Window” itself. Data can be displayed on the “Main Chart” (left section of the main window) and/or “Profile Composite Chart” (right section of the main window). Figure 3 illustrates the Main Window, which is the destination for all graphical output resulting from user interaction with the other NIDAS–C modules. The DRM, and the DIM perform the preparatory data selection, data processing, and data management functions required to generate the visual displays that appear within the Main Window.
2.2.2.1 Main Chart

The "Main Chart" section of the Main Window, as shown in Figure 3, displays plotted data in a geographical coordinate (map) context using contours, points, and/or user selectable area color fills. The "Main Chart" retains all datasets selected from the DRM during execution unless specifically removed by deselecting it. To remove a specific data display, deactivate the "Display" button for the appropriate data category within the DRM "Data Selection" window (see Figure 9). When deactivated, the "Display" button for that data type will no longer be highlighted.

2.2.2.2 Profile Composite Chart

The "Profile Composite Chart" section of the Main Window, as shown in Figure 3, is used to plot temperature, salinity, or sound speed versus depth profiles. The profile composite chart accepts GDEM, GRID1, GRID2, MOODS, AUX1, and AUX2 profiles. To remove a plot display from the "Profile Composite Chart", deactivate the "Display" button for the appropriate profile data category within the DRM "Data Selection" window (see Figure 9).

2.2.2.3 Menu Bar

The NIDAS--C "Main Window" contains a menu bar with interactive menu headers labeled "File", "Tools", and "Help". Each menu header provides access to additional NIDAS--C features. Figure 4 illustrates all the available menu options, which are described in detail.
2.2.2.3.1 File Pulldown Menu

The options available from the “File” pulldown menu are “Main Window” (Main Chart), “Profile Window” (Profile Chart), “Select Parameter”, and “Exit”.

- **“Main Chart”** – The “Main Window” menu item offers the following choices:
  - “Repaint” – Selecting the “Repaint” option removes (erases) any polygons of locations that have been created or overlaid within the “Main Chart”. If there are no polygons or overlaid locations, no changes will be made to the “Main Chart”.
  - “Default Region” – Selecting the “Default Region” option returns the “Main Chart” to its default scale or resolution subsequent to scaling (zoom) procedures that have enlarged the original resolution of the “Main Chart” display.
  - “Axis Options” – Selecting “Axis Options” produces a pop-up window that allows the user to change the latitude and longitude interval markings (tick marks) on the “Main Chart” (see Figure 5a). The axis interval values are modified by entering new values within the textboxes in degrees of arc. Clicking the “Ok” button confirms the new values and closes the window. Clicking the “Exit” button closes the pop-up window, but makes no changes to pre-existing latitude/longitude tick marks.
- "Profile Chart" - The "Profile Window" menu item offers option choices that are similar to the "Main Chart" menu item.
  - "Repaint" - Selecting the "Repaint" option removes (erases) any polygons or overlaid profiles that exist for the "Profile Chart". If there are no polygons or overlaid profiles, no changes will be made to the "Profile Chart".
  - "Axis Options" - Selecting the "Axis Options" brings up a pop-up window that allows the user to change the X Min, X Max, Y Min, and Y Max range limits for the "Profile Chart" (see Figure 5b). Changes can be made by entering new values in the respective textboxes. Clicking the "Ok" button confirms the new values and closes the window. Clicking the "Exit" button closes the pop-up window, but makes no changes to pre-existing range limit values.

![Axis Options](a)

![Axis Options](b)

Figure 5. (a) The NIDAS-C "Axis Options" pop-up window for the "Main Chart". (b) The NIDAS-C "Axis Options" pop-up window for the "Profile Chart".
Select Parameter – The “Select Parameter” menu item allows selection of the parameter to be displayed on the horizontal axis of the “Profile Chart”. The choices available are: “Temp” (temperature), “Snd Speed” (sound speed) and “Salinity”. After a parameter has been selected, the “Profile Chart” will automatically adjust, if necessary, to accommodate the new parameter. If the selected parameter was previously designated to be the active parameter, there will be no change in the “Profile Chart”.

Exit – Upon clicking the exit button, the “Exit” pop-up dialog will be displayed. This pop-up window allows confirmation of the desire to exit (clicking the “Ok” button) or to return to the application (clicking the “Cancel” button).

2.2.2.3.2 The Tools Pulldown Menu

The options available from the “tools” pulldown menu are “Status”, “Export”, and “Update DB”.

Status – The “Status” menu item provides time, date, and plotting color information about each data type selected from the DRM “Data Selection” window. The “Data Selection Status” scrollable pop-up window (see Figure 6) appears in response to the selection of the “Status” menu item. The status information is displayed within the “Data Selection Status” window. To close the “Data Selection Status” window, click the “Exit” button on that window.

Export – The “Export” menu item supports the export of all the available data types either in binary or in ASCII format. The “Export Data” pop-up window (see Figure 7) appears in response to the selection of the “Export” menu item. It provides header entry textboxes, suggested (default) filename(s) and, buttons for selecting binary or ASCII output.
Before datasets can be exported, at least one of the exportable data types must have been selected, and polygons must have been constructed. Depending upon the data types displayed, the "Export" menu lists filenames in a textbox for each data type. The user may enter the required information in the textboxes (pressing <return> after each completed text entry). The "Export Data" window also allows the user to make either of the following two choices: 1) All in Last Polygon (Default), which is to export all the profiles in the last drawn polygon, or 2) All Previous Profile Isolate Selections, which is to export all the selected isolated profiles. Also the user can select or deselect profile flags, based on "Temperature" and "Salinity", by clicking on the particular flag buttons. Once all the required export data has been entered, click the "Ok" button to export the data. To close the "Export Data" window, click the "Exit" button.

![Image of the Export Data window](image)

**Figure 7.** The Tools "Export Data" pop-up window.
• **Update DB** - The Tools "Update DB" menu item supports updating the database of the flags of individual profiles set over a period of multiple profile isolations discussed in section 2.2.4.4.

2.2.2.33 The Help Pulldown Menu

The "Help" pulldown menu offers on-line assistance to the user. Help is available on "Layout", "Data Selection", and "Data Analysis" from the menu items that appear when the "Help" menu header is selected. Help on each subject is provided in a series of pop-up help screen windows that appear in response to menu item selection. To close a help screen, click the "Ok" button on the window.

2.2.2.4 Remark

The buff-colored "Remark" textbox is located in the lower left corner of the "Main Window" display. The "Remark" textbox provides notification of errors, event status and communicates instructions for follow-on interaction by the user.

2.2.2.5 Repaint

The "Repaint" button is located in the lower right corner of the "Main Window" display. "Repaint" eliminates all polygons and overlaid position plots on the "Main Chart", and overlaid profiles on the "Profile Chart". Nothing happens in response to clicking "Repaint" if there are no polygons, position plots or overlaid profiles.

2.2.3 Data Retrieval Module (DRM)

The Data Retrieval Module (DRM) controls the display and selection of data for the NIDAS-C CSCI. User interaction with the DRM is handled via the "Data Selection" portion shown in Figure 8. There are three choices for each data type listed in the "Data Selection" window. They are "Display", "Data", and "Options". The "Display" buttons select data types be viewed in the "Main Chart" or "Profile Composite Chart" within the NIDAS "Main Window" display.

<table>
<thead>
<tr>
<th>Data Selection</th>
<th>Interact</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display Data Options</td>
<td>Zoom Polygon</td>
</tr>
<tr>
<td>BATHY</td>
<td>☐ ☐ ☐</td>
</tr>
<tr>
<td>COAST</td>
<td>☐ ☐ ☐</td>
</tr>
<tr>
<td>GDEM</td>
<td>☐ ☐ ☐</td>
</tr>
<tr>
<td>GRID1</td>
<td>☐ ☐ ☐</td>
</tr>
<tr>
<td>GRID2</td>
<td>☐ ☐ ☐</td>
</tr>
<tr>
<td>MOODS</td>
<td>☐ ☐ ☐</td>
</tr>
<tr>
<td>AUX1</td>
<td>☐ ☐ ☐</td>
</tr>
<tr>
<td>AUX2</td>
<td>☐ ☐ ☐</td>
</tr>
</tbody>
</table>

Figure 8. NIDAS-C Data Retrieval Module (DRM) and the Data Interactive Module (DIM) display window. The "Data Selection" part deals with the DRM while the "Interact" and the "Grid" parts deal with the DIM.
The "Data" buttons produce tailored dialog pop-up windows that allow selections from available parameters contained in the dataset. The "Options" buttons produce data dialog pop-up windows tailored to each data type, offering other user options such as color. The functionality of the "Display", "Data" and "Options" buttons are described for each data type category in the following subsections.

2.2.3.1 BATHY (Bathymetry)

2.2.3.1.1 Display

Selecting the BATHY "Display" button produces a contour plot of the bottom depth on the "Main Chart."

2.2.3.1.2 Data

Bathymetry does not vary with time or day. It is determined by the region designated for the "Main Chart". The BATHY "Data" button is a non-interactive button; that is, no user interaction is needed in order to read the bathymetry. As soon as the "Data" button is pressed, the bathymetry for that region is read.

2.2.3.1.3 Options

When the BATHY "Options" button is clicked, a pop-up window is produced which allows modification of the maximum and minimum data values and the interval between plotted contours (see Figure 9). To modify values, select the appropriate text widget, enter the desired value from the keyboard and press the <return> key. The "Ok" button accepts the changes and removes the pop-up window. The "Reset: button restores all values to their defaults.

<table>
<thead>
<tr>
<th>Bathymetry Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Min</td>
</tr>
<tr>
<td>Max</td>
</tr>
<tr>
<td>Interval</td>
</tr>
</tbody>
</table>

Figure 9. DRM "Bathymetry Options" pop window.

2.2.3.2 COAST (Coastline)

2.2.3.2.1 Display

Clicking the "Display" button associated with the COAST data type plots the coastline on the "Main Chart".
2.2.3.2.2 Data

Clicking the "Data" button associated with the COAST data type produces the "Coastline Data" pop-up window illustrated in Figure 10. The "Coastline Data" pop-up window allows selection of the coastline resolutions (1, 3, 8, or 20 kilometers) which requires the user to select a particular type of coastline. When the "Coastline" button is clicked, a pull-down menu lists the four coastline resolutions. The selected resolution is displayed in the textbox to the right of the pulldown menu. Clicking the "Ok" button accepts any changes made to coastline resolution and closes the pop-up window. Clicking the "Reset" button restores the coastline resolution to its default value.

![Coastline Data](image)

Figure 10. DRM "Coastline Data" pop-up window for the Coastline data types.

2.2.3.2.3 Options

Selecting the "Options" button associated with the COAST data type within the DRM "Data Selection" window produces the "Coastline Options" pop-up window as shown in Figure 11. A "Colors" pulldown menu offers a choice among eight different color options in which a coastline may be displayed on the "Main Chart". The selected color is displayed in the textbox to the right of the pulldown menu. Clicking the "Ok" button accepts the indicated color and closes the "Coastline Options" pop-up window. Clicking the "Reset" button restores the original color, which may be accepted (by clicking "Ok") or modified again (using the "Colors" pulldown menu).

![Coastline Options](image)

Figure 11. DRM "Coastline Options" pop-up window for the Coastline data type.

2.2.3.3 MOODS

2.2.3.3.1 Display

The display button for MOODS displays the MOODS location information on the Main Chart and profiles of Depth vs. the current parameter on the Profile Chart for the selected data set.
2.2.3.3.2 Data

When the MOODS data button is selected, the MOODS data selection pop-up window will appear as shown in Figure 12. This Window will contain various user-selectable options. The “Read” button initiates the retrieval of data from the database using the parameter range values shown in the “selection status” of the pop-up window. The “Remark” section of the “Main Window” displays “Reading MOODS Data” during data retrieval and “finished reading MOODS Data” when retrieval is completed. The “Exit” button closes the MOODS data selection pop-up window.

The “Selection Status” section displays the currently set minimum and maximum values for the various parameters. When retrieving data for the database the values last displayed in the selection status area will be used. At any given time either the minimum or maximum values can be changed by selecting the “minimum” or the “maximum” button in the selection status area and selecting the desired values from the “Data Selection” area.

The “Data Selection” section of the window allows the user to set the minimum and maximum values of the following parameters: class code, instrument type, source code, month, cruise ID, water depth, latitude, longitude, parameters and time. To set any values, either the “Minimum” or “Maximum” button from the “Selection Status” area must be selected. The class code, instrument type, source code, and month can be set from their respective scrollable lists, by selecting the desired value on the list. The parameters can be set by moving the "Number of Parameters" slider bar to the left or right till the desired value is shown. The parameter can have one of the following values:

- 1 – Salinity
- 2 – Temperature
- 3 – Both Temperature and Salinity
- 4 – Sound Speed

Cruise id, water depth, latitude, and longitude can be set by typing the required values in the corresponding text boxes and pressing the <return> key. To select a particular version, the “Versions” button is selected. This results in a pop-up list window as shown in Figure 13, from where the desired version can be selected. Time can be set by selecting the “Time” button (see Figure 14) and selecting the desired time. Once a selection is made the corresponding “Minimum” or “Maximum” text box of the particular parameter, in the “Selection Status” area, will reflect the change.
Figure 12. DRM "Data Selection" pop-up window for the MOODS data type.

Figure 13. DRM "Version Selection" pop-up window for selecting the dataset version.
2.2.3.3.3 Options

The "MOODS Options" pop-up window illustrated in Figure 15 supports specification of 1) up to three date ranges centered on the listed "Center Date" (Julian); 2) colors for plotting MOODS profiles; 3) colors for plotting polygons; 4) colors for profile isolation; 5) "On/Off" toggle buttons for locations, profiles, and depths; 6) profile flag settings; 7) point size for data, polygon, and isolate; and 8) line width for data, polygon, and isolate. The Julian center date is automatically calculated from the dataset and listed in the "Center Date" text box. The user can also enter a different center date by entering a new date from the keyboard and pressing the <return> key in the "Center Date" text box. Below the "Center Date" text box are three textboxes labeled "+/-", "-" and "+". The value entered in the "+/-" textbox is added and subtracted from the center date to obtain a date range. To further reduce the lower limit of the data range, enter a number into the "-" textbox. Similarly, a number may be entered into the "+" textbox to increase the upper limit of the date range. For each Julian range entered, the user may select a color for displaying profiles falling within that date range, and a color for polygoned profiles within that date range. When clicked, the "Color" button produces a pulldown menu offering eight color options. A color may be selected by dragging the mouse cursor over the desired color and releasing. The selected color will be displayed within the "Color" textboxes. The color is similarly set for profile isolation. The location, profile, and depths On/Off buttons are set by clicking on the respective buttons. The point sizes and line widths can be set by sliding the respective slide bar until the desired value is shown. The desired flagged profiles can be set by clicking the "Profile Flags" button which brings up pop-up window (see Figure 16) and selecting the desired flags. Clicking the "Reset" button returns all values to their original defaults. Clicking the "Ok" button closes the "MOODS Options" pop-up window, accepting the criteria established therein.

Figure 14. DRM "Time Selection" pop-up window for setting MOODS date/time criteria.
NIDAS–C User's Manual

Figure 15. DRM "MOODS Options" pop-up window for the MOODS data type.

<table>
<thead>
<tr>
<th>Temperature</th>
<th>Salinity</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 = Not Yet Examined</td>
<td>0 = Not Yet Examined</td>
</tr>
<tr>
<td>1 = Good Profile</td>
<td>1 = Good Profile</td>
</tr>
<tr>
<td>2 = Coarse Resolution</td>
<td>3 = Inconsistent</td>
</tr>
<tr>
<td>3 = Inconsistent</td>
<td>4 = Duplicate (Keep)</td>
</tr>
<tr>
<td>4 = Duplicate (Reject)</td>
<td>5 = Duplicate (Reject)</td>
</tr>
<tr>
<td>5 = Duplicate (Reject)</td>
<td>6 = Suspect</td>
</tr>
<tr>
<td>6 = Suspect</td>
<td>7 = Needs Repair</td>
</tr>
<tr>
<td>7 = Needs Repair</td>
<td>8 = Wrong Location</td>
</tr>
<tr>
<td>8 = Wrong Location</td>
<td>9 = Bad Profile</td>
</tr>
</tbody>
</table>

Figure 16. DRM "Profile Flags" pop-up window for the MOODS data type.

2.2.3.4 AUX1/AUX2

The AUX1 and AUX2 data types use the same interfaces as the MOODS data type in the data, display, and options categories. Refer to section 2.2.3.3.
2.2.3.5 GDEM

2.2.3.5.1 Display

The display button for GDEM displays the GDEM location information on the Main Chart and profiles of Depth vs. the current parameter on the Profile Chart for the selected data set.

2.2.3.5.2 Data

When the GDEM data button is selected, the GDEM data selection pop-up window will appear as shown in Figure 17. This Window will contain various user-selectable options. The "Read" button initiates the retrieval of data from the database using the parameter range values shown below the "Minimum" and "Maximum" buttons of the pop-up window. The "Remark" section of the "Main Window" displays "Reading GDEM Data" during data retrieval and "finished reading GDEM Data" when retrieval is completed. The "Exit" button closes the GDEM data selection pop-up window.

![Data Selection Window](image)

Figure 17. DRM "Data Selection" pop-up window for the GDEM data type.

To set any of the parameter values such as Month, Number of Parameters, Water depth, Latitude, and Longitude the "Minimum" or the "Maximum" button has to be selected first. The Month can be set by selecting the desired month from the list while the Number of Parameters can be set by moving the slider bar to the left or right till the desired value is shown. The water depth, latitude, and longitude can be set by typing the required values in the corresponding text boxes and pressing the <return> key. To select a particular version, the "Versions" button is selected. This results in a pop-up list window as shown in Figure 13, from where the desired version can be selected.
2.2.3.5.3 Options

The GDEM Options pop-up window, as shown in Figure 18, allows for specifying the following options: 1) Data, Polygon, and Isolate Colors; 2) Location, Profiles, and Depth On/Off flags; 3) Profile, Polygon, and Isolate line widths; and 4) Data, Polygon, and Isolate point sizes. The line widths and the point sizes can be set by moving the corresponding slider bars till the desired value is displayed. These settings control the thickness of the lines and points in the Main Chart and the Profile Chart areas. Clicking the “Reset” button returns all values to their original defaults. Clicking the “Ok” button closes the “GDEM Options” pop-up window, accepting the criteria established therein.

![GDEM Options](image_url)

Figure 18. DRM "GDEM Options" pop-up window for the GDEM data type.

2.2.3.6 GRID1/GRID2

The GRID1 and GRID2 data types uses the same interfaces as the GDEM data type in the data, display, and options categories. Refer to section 2.2.3.5.

2.2.4 Data Interactive Module (DIM)

The DIM supports manipulation of ocean data in the following ways:

- Identification of data subsets by constructing polygons within the "Main Chart" or "Profile Chart";
- Enlargement of resolution (zoom) for improved interpretation/analysis;
• Isolation of profiles;
• Interpolation of displayed data into a contour;

The DIM "Interact" and "Grid" window (see Figure 8) controls selection of data manipulation options within NIDAS-C. To activate an option, click its associated button.

2.2.4.1 Zoom

After selecting the "Zoom" button in the DIM "Interact" window, the zoom options pop-up window (see Figure 19) will appear. If the "Zoomed Profiles Only" button is selected, only those profiles within the zoomed subregion of the "Main Chart" will be plotted on the "Profile Composite Chart". If the "Overlay Zoomed Profiles" button is selected, profiles within the Zoom subregion will be plotted on the top of any existing profiles within the "Profile Composite Chart". When the "Exit button is clicked, the Zoom options pop-up window is closed and the "Zoom" function is activated to specify the subregion for enlargement within the "Main Chart". To specify the subregion, use the rubber band technique defined in Appendix A. The "Zoom" function will not work unless the specified subregion is completely visible within the "Main Chart" window. Once the subregion for enlargement has been specified, the "Main Chart" window will display it. Profiles within the zoomed subregion will be plotted within the "Profile Composite Chart" in accordance with the plotting option selected in the zoom options pop-up window. To return the "Main Chart" display back to its normal region depiction, select the "Default Region" menu item found under the "File" menu header (Section 2.2.3.1).

![Zoom Options Pop-up Window](image)

Figure 19. DIM "Zoom Options" pop-up window.

2.2.4.2 Polygon

After selecting the "Polygon" button in the DIM "Interact" window, polygon construction functions become active within either the "Main Chart" or the "Profile Composite Chart". The following rules apply in constructing a polygon:

- The **left mouse button** is used to select the "Main Chart" or "Profile Composite Chart" for polygon construction. Simply place the mouse cursor within the border of the "Main Chart" or the "Profile Composite Chart" and click the left mouse button. The border of the chart will be highlighted in blue to indicate that it has been selected.
- The **middle mouse button** is used to establish the corner points of a polygon. Maneuver the cursor to the position desired for a corner point and click the middle mouse button. At least three points must be defined in this manner to create a polygon.
- The right mouse button is used to close the polygon, which indicates that the definition of polygon corner points has terminated. The three (or more) polygon corner points will be connected, in the order in which they were created, to form the polygon. If the polygon does not appear to be drawn correctly, click the "Repaint" button located in the lower right corner of the "Main Window" display to remove existing polygons. If less than three corner points were defined before clicking the right mouse button, a message will appear in the "Remark" textbox stating "polygon should have at least three points. Start again." In this case, you need to "repaint" and start over.

If the polygon is drawn from the "Profile Composite Chart", the profiles that have a depth point inside the polygon will be highlighted. All data within the polygon will be highlighted on both charts.

2.2.4.3 Polygon Options

The Polygon Options pop-up window, as shown in Figure 20, allows for specifying the following polygon options: 1) Vertex and Edge colors, 2) Vertex size, 3) Edge Line width, and 4) Vertex symbol. The colors can be set by selecting the required color from the corresponding color pull-down list. The vertex size and the edge line width size can be set by moving the corresponding slider bars till the required values are shown. The vertex symbol can be set from the symbol pull-down list. The symbol list contains seven symbols from which can be chosen: *, O, •, □, ▼, □, or ◇. To select it from this options window select the "Ok" button.

![Polygon Options](image)

Figure 20. DIM "Polygon Options" pop-up window.

2.2.4.4 Profile Isolation

The Profile Isolation pop-up window, as shown in Figure 21, allows for isolating individual profiles of the currently displayed data profiles that has been polygoned. To list the profiles of a particular data type, click on the corresponding data type button in the "Current Data Type" section of the pop-up window. Individual or multiple profiles can be selected by selecting the "Single" or "Multiple" button from the "List Selecting Policy" section of the pop-up window. To select the profile(s)
click on the respective items on the list. The selected profiles are then highlighted in the "Profile Composite Chart" area and their corresponding locations are also highlighted in the "Main Chart" area. The pop-up window also supports the following for the profile(s) selected: 1) Flagging, 2) Updating database, 3) Exporting, and 4) Deleting. Click on the "Exit" button to exit from "Profile Isolation".

<table>
<thead>
<tr>
<th>Current Data Type</th>
<th>Date</th>
<th>Course New Id</th>
<th>Lat</th>
<th>Long</th>
<th>Instrument Source</th>
<th>Depths</th>
</tr>
</thead>
<tbody>
<tr>
<td>ØGdem</td>
<td>1/14/1986</td>
<td>0 1023111</td>
<td>36.000000</td>
<td>124.309990</td>
<td>33</td>
<td>22</td>
</tr>
<tr>
<td>ØMoods</td>
<td>1/14/1986</td>
<td>0 1023106</td>
<td>36.000000</td>
<td>123.980000</td>
<td>33</td>
<td>22</td>
</tr>
<tr>
<td></td>
<td>1/22/1986</td>
<td>0 1023999</td>
<td>36.069990</td>
<td>123.930000</td>
<td>33</td>
<td>22</td>
</tr>
</tbody>
</table>

Figure 21. DLM "Profile Isolation" pop-up window.

2.2.4.4.1 Flagging

The "Flag" button is selected to set a particular flag for the profile(s) isolated (see Figure 22). To set a particular flag, click the required button. Only one flag can be set at a time. To reset the flag(s) click on the "Reset" button. To exit from the flag option click on the "Exit" button.

Figure 22. "Flag" options pop-up window for profile isolation.
2.2.4.4.2 Update Db

Click on the "Update Db" button to update the database with the changes made to the flags of the isolated profile(s). This button only updates the flags.

2.2.4.4.3 Export

Click on the "Export" button to export the isolated profile(s) (see Figure 23). Select "Binary" or "Ascii" to export in the binary or the ascii format. Type the output file names and header information and press the <return> key in the corresponding text boxes. To export the data, click the "Ok" button. To exit from the export option, click the "Exit" button.

![Figure 23. "Export" options pop-up window for profile isolation.](image)

2.2.4.4.4 Delete

Click the "Delete" button to delete the isolated profile(s). The profiles are only deleted from memory and not the database, regardless of pressing the "Update Db" button.

2.2.4.5 GRID (Interpolation)

2.2.4.5.1 Charter

To interpolate the displayed data to a contour, select one of the interpolation routines from the "Method" pull-down menu. (Only one interpolation routine is available for this release. This routine is called "Charter" with a chrtr8 reader. This routine was provided by NAVOCEANO. "Other" is shown only to illustrate that additional routines can be added. "Other" has no function in this release.) The user is then given the option to select a particular data type from among the data types currently displayed as shown in Figure 24. Select a data type by clicking one of the data type buttons to bring up the "Charter Values" pop-up window, as shown in Figure 25, to set the various charter grid data values. The data values that can be set are 1) Grid Interval; 2) Lower left, and upper right latitudes; 3) Lower left, and upper right longitudes; 4) Depth; and 5) Smooth value. The depth value can be set by selecting the desired value from the "Depth" list, while the smooth value can be set by selecting the "Smooth" or "Unsmoothed" option from the pull-down menu located under the Depth list. The "Smoothed" option is the "fort.29" output file produced by the charter routine. The "Unsmoothed" option is the "fort.14" output file produced by the charter routine. The rest of the data values can be set by typing in the corresponding text boxes. To interpolate the data and exit from
the pop-up window, select the “Ok” button. To exit from this window, select the “Cancel” button. The “Help” button provides on-line help on this topic.

![Charter Data Type Selection]

Figure 24. DIM "Charter Data Type Selection".

![Charter Values]

Figure 25. DIM "Charter Values" pop-up window.

2.2.4.5.2 Display

After the data has been interpolated, it is ready to be displayed. To display the contour, select the “Display” button. The resulting contour is shown in the "Main Chart" window.

2.2.4.5.3 Options

Clicking the “Options” button produces the “Charter Contour Options” pop-up window, as shown in Figure 26. The user can set the following charter contour options in this window: 1) min, max, and interval values; 2) land mask and label on/off flags; 3) isoline and label colors; 4) isoline...
width; and 5) label height. The min, max, and interval values can be set by typing in the corresponding text boxes, while the land mask and the label on/off flags can be set by clicking the corresponding buttons. The colors are set by selecting the required color from the list of colors displayed when the "Isoline Color" and the "Label Color" buttons are selected. The isoline width and the label height are set by moving the slider bars till the desired values are obtained. Click the "Ok" button to register the values and exit from the window. Click the "Reset" button to reset any values set.

Figure 26. DIM "Charter Contour Options" pop-up window.

3 ERROR MESSAGES

Some of user error messages and a small description of the message and its meaning are provided below. If there are any other problems with NIDAS-C that the DataBase Administrator can not fix, then call user / technical support at:
Phone: (601) 688-3085
Fax: (601) 688-7100
E-Mail: abbott@cast.msstate.edu

3.1 Starting NIDAS-C

- "Error from db_start" – NIDAS-C could not open and start the database. Contact the DataBase Administrator.

3.2 Reading Data

- "No versions available" -- There are no versions in the database for the data type you have selected. Ingest data first and then try to read it.
• "Number of Versions is limited to 12." – You can select multiple versions when reading data, but the number of versions is limited to 12. Select your versions again.

• "No data available for given conditions." – No data meets the minimum and maximum criteria. Increase the range on the minimum and maximum.

• "Multiple Versions, DB Update Disabled" – When multiple versions are read in, the flag updating is disabled. You can flag the data but you won’t be able to update the database.

3.3 Polygon

• "Polygon should have at least three points. Start again." – In order to create a polygon, you must have at least three points. "Repaint" and start the polygon again.

3.4 Zoom

• "Zoom is not done correctly." – In order to zoom, you must make a rectangular box around the area to zoom. If you make a line, this message will be given.

3.5 Export

• "Display of some datasets is required to export data." – At least one type of data has to be read into memory and displayed on the "Main Chart" in order to export data.

• "Polygon has to be drawn to export data." – The "Export" utility exports data that has been polygoned. Draw a polygon, then export.

• "Error. File name should start with alphabetic character only." – The filename provided to the export utility must start with a character from a/A to z/Z.

• "Open file error, for writing in */nc_export." – The '*' stands for the value in the environment variable "NIDASC_EXP". Check this variable and make sure it is pointing to a valid directory and that that directory contains another directory called "nc_export".

3.6 Interpolation (Charter)

• "Display of gdem or moods required" – At least one type of data has to be read in and displayed on the "Main Chart" in order to interpolate data.

• "Display of Temperature or Salinity required" – The interpolation utility requires that either temperature or salinity be the parameter being displayed. This can be checked by looking at the "Profile Composite Chart" and seeing what the title is. It needs to be either "Temp vs Depth" or "Sal vs Depth".
NIDAS-C User's Manual

- "All Charter fields must be entered" – All of the values on the "Charter Values" pop-up window must be provided. One or more values has been left out.

- "Lat/Lon fields must include a '.'! (ex: Degrees,Minutes)" – The latitude and longitude must have a '.' to separate the degrees from the minutes.

- "Open file error, for writing in temp file." – This temp file is being opened for writing in the "/tmp/" directory. Make sure that you can write to this directory and that there is not a file by the name of "charter_script".

- "Error from split-b — Contour not created" – Something is wrong with the split-b program. Split-b is part of the interpolation utility and it is an executable. Make sure it is in your executable path. Also make sure that you can write to the "/tmp/" directory and in the current directory. The current directory is the directory that NTDAS-C was started from.

- "Error from chrtr8 — Contour not created" – Something is wrong with the chrtr8 program. Chrtr8 is part of the interpolation utility and it is an executable. Make sure it is in your executable path. Also make sure that you can write to the "/tmp/" directory and in the current directory. The current directory is the directory that NTDAS-C was started from.

4 NOTES

4.1 System Considerations

Installation is site specific and tailorable to the environment. Appendix C provides information specific to installation of NIDAS-C within the NAVOCEANO computing environment. NIDAS-C may be installed and executed from SunOS 4.x, SunOS 5.x (Solaris), SGI 4.x, and SGI 5.X. However, some graphical screens produced by NIDAS-C are color and memory intensive, and will cause termination of the software if memory and color resources are insufficient.

4.2 System/Software Requirements

NIDAS-C is an integrated software system that requires the presence of both specific commercial off-the-shelf software and government-provided software.

- NIDAS-C was designed for execution under control of the UNIX operating system on SunOS 4.x, SunOS 5.x (Solaris), SGI 4.x, and SGI 5.X.
- NIDAS-C requires the presence of the X-Windows client-server environment.
- The Open Software Foundation's (OSF) Motif Toolkit (library) must be present and available in the execution environment.
• A runtime version UNIRAS ag/X Toolmaster software must be installed on the system and available in the execution environment to support NIDAS-C graphical display options.

• The Oracle relational database engine must be installed on the system and available for execution as the vehicle for accessing data contained in the NIDAS-C database.

• Of interest to programmers, the software code for this version of the NIDAS-C was compiled using C and Fortran Compilers.

• NIDAS-C is an interactive application. It supports all standard X-Windows mouse and keyboard functions.

4.3 Directory Map

NIDAS-C software executables have been designed to execute using directory paths defined via UNIX environmental parameters and path names defined within user "login" or "cshrc" files. These parameters must be determined during installation since they are system dependent.

4.4 Security

NIDAS neither supports nor restricts the overall classification of the computing environment; however, classification codes are contained in the header information of each profile. The NDBA controls access to NIDAS data by authorizing levels of access based on the clearance held by individual users.
APPENDIX A. GLOSSARY OF TERMS

Bathymetric – Pertaining to the depth of the ocean.

Button – When used in relation to the mouse device, a button is one of three pressure switches, which may be pressed (clicked) to control some feature of the screen display. When used in relation to the monitor display, a button is a labeled area of the on-screen graphical design that resembles a switch which can be made active by pressure.

Click – The act of pressing a button on the mouse. The term "click on", or simply "click", is frequently used to indicate that the user should maneuver the mouse cursor to a specified location on the screen (usually an area designed to resemble a button) and press (click) the appropriate button on the mouse.

Computer Software Configuration Item (CSCI) – a software application or a major component thereof.

Computer Software Component (CSC) – a top level functional module within a computer software configuration item (CSCI). CSC's are generally considered to be one structural level below the CSCI.

Cursor – A graphical symbol that identifies a position on a computer monitor screen. A cursor is sometimes controlled by moving a mouse device; otherwise, it is controlled from the keyboard, usually with the arrow keys.

Data Interactive Module (DIM) – NIDAS module that performs data manipulation functions and processing required for display and interpretation of data.

Data Retrieval Module (DRM) – NIDAS module responsible for identifying, obtaining and formatting data obtained from the NIDAS (NEONS) database.

Display – Synonymous with the computer monitor screen; also, to demonstrate or to show.

Drag – The act of pressing and holding a button on the mouse device and moving the mouse to control a cursor's position on the monitor screen. The purpose of dragging the mouse device is to define an area on the screen or to move a graphical object to another location on the screen.

Graphical User Interface (GUI) – NIDAS module responsible for interfacing with the user and controlling the functionality of the main NIDAS display.

Julian – The day of the year according to the Julian calendar which begins on January 1. A Julian date does not include a year as part of its format.

List – a simple series of words or numerals.

Listbox – An outlined area of the display which contains a list of textual information. Selection of text within a list is accomplished by placing the mouse cursor over the appropriate entry and clicking a button on the mouse.
Metadata – Information about a dataset, either descriptive or definitive, as to quantity, quality, quantity or format.

Mouse – A hand controllable device used to interact with images displayed on the computer monitor screen. When a mouse is moved, a cursor on the screen moves in the same direction as the mouse. One or more buttons may be present on a mouse for invoking an action on screen at the corresponding cursor position.

Profile – A sequential listing of parameters keyed to a reference structure. A bathymetric profile contains sequential depth/parameter groups.

Pull-down Menu – A listing of procedural options that appears in response to activation of an appropriately labeled (visible) button referred to as the menu header. Options are selected by clicking on the menu header to display the options, followed by clicking the button labeled to indicate the desired option.

Rubber Band – The act of dragging the mouse to define an area on the screen. A mouse button is pressed and held while the mouse is maneuvered to position the on-screen cursor at a desired final position; then, the mouse button is released.

Screen – The display surface of a computer video monitor where images appear.

Scroll Bar – The graphical image of a narrow bar with arrows embedded at both ends and, optionally, a movable (sliding) button between them. The scroll bar is used to position a portion of an image or text for viewing inside a bound area that is smaller than the whole image or text. Scrolling is accomplished by placing the mouse cursor on one of the arrows and pressing the mouse button. Scrolling may also be accomplished by placing the mouse cursor over the sliding button (if present) and dragging the sliding button to a new position along the scroll bar.

Textbox – An outlined area of the display that contains textual information. Text in a textbox may sometimes be edited; however, the usual purpose of a textbox is to provide information to the user.

Widget – “...a graphical device capable of receiving input from the keyboard and the mouse and communicating with an application or another widget by means of a callback. Every widget is member of only one class and always has a window associated with it.” (from: OSF/Motif Programmer's Guide, Rev. 1.1 Open Software Foundation, Prentice Hall, Englewood Cliffs, NJ, 1991, p. GL-13.)

Window – An outlined area of the screen whose contents are confined to the outlined boundary and controlled by user interaction (with buttons, menus, etc.). A window is usually a top level structure closely tied to the operating environment of the computer.

Zoom – The graphical scaling process whereby a screen display item is enlarged or reduced in size.
APPENDIX B. LIST OF ACRONYMS

ASCII – American Standard Code for Information Interchange
AUX1 – Auxiliary MOODS Dataset 1
AUX2 – Auxiliary MOODS Dataset 2
CAST – Center for Air Sea Technology
CLIMO – Climatology
CSC – Computer Software Component
CSCI – computer software configuration item
DBDR – Database Design Requirement
DBFR – Database Functional Requirement
DOD – Department of Defense
DIM – Data Interactive Module
DRM – Data Retrieval Module
GDEM – General Digital Environmental Model
GUI – Graphical User Interface
Lat – latitude
Lon – longitude
Max – Maximum
Min – Minimum
MOODS – Master Oceanographic Observation Data Set
MSU – Mississippi State University
NASA – National Aeronautics and Space Administration
NAVOCEANO – Naval Oceanographic Office
NDBA – NIDAS Database Administrator
NDMS – NIDAS Data Management System
NEONS – Navy Environmental Operational Nowcast System
NDR – NIDAS Data Requirement
NFR – NIDAS Functional Requirement
NIDAS-C – Naval Interactive Data Analysis System – Climatology
OSF – Open Software Foundation
Appendix B

**RDBMS** – Relational Database Management System

**Sal** – salinity

**Snd speed** – sound speed

**SQL** – Structured Query Language

**Temp** – temperature
APPENDIX C. NIDAS-C INSTALLATION PROCEDURES

The following instructions explain how to install NIDAS-C. These instructions have been provided with the NIDAS-C software as a "README" file, and contain the following sections:

- Prerequisites
- Creating the proper Environment
- Importing the DataBase
- Installing the Software
- Clean-Up
- Remarks

Prerequisites

The software must be downloaded off the tape and in the correct directory to where NIDAS-C is to be installed. The software is in the form of a tar file that has been loaded onto the tape. The tar file has been loaded onto the tape from a SunOS system using tar to load it with. The System Administrator will need to help with this. After the tar file has been downloaded off the tape and put into the proper directory, it can be untared with the command tar -xvf ONIDAS_SW.tar. This will create a directory call ONIDAS_SW. Remember this directory as it will be used in creating the user environment.

Oracle must be up and running and a database created for nidas. For example, the database can be named nidas. An oracle user must exist with the name neons with a password of neons. Caution must be exercised when creating the nidas database to make sure that the rollback segments and the tablespaces are large enough. When a transaction is initiated, a rollback segment is selected to hold that transaction. Only one segment is used per transaction. Therefore, all of the rollback segments have to be large enough to handle the largest transaction. The recommendation is to have one or more rollback segments with at least the size of 50M. The following is the required name and recommended sizes for the tablespaces:

- GEOGRAPHIC – This is for the geographic data. Size: 200M
- INDEX_PRIMAIRE_NEONS – This is for the indexes for the primary data. Size: 200M
- PRIMAIRE_NEONS – This is for the primary data. Size: 350M
- NEONS – This is for other meta data. Size: 200M

The UNIRAS graphics package must have been installed and the license daemon running.
Appendix C

Creating the proper Environment

These changes and additions are to be made to each user's `.cshrc` file. For this example, NIDAS–C is to be installed in the directory `/usr/people/nidas`. After making these changes, the `.cshrc` file must be sourced. This can be done by the command `source ~/.cshrc`.

- Make Sure: UNIDIR points to the UNIRAS software.
  (ex: `setenv UNIDIR /usr/uniras/6v4a`)
- Make Sure: UNIRAS login file has been sourced.
  (ex: `source $UNIDIR/base/uniJogin`)
- Make Sure: ORACLE_HOME points to the oracle software.
  (ex: `setenv ORACLE_HOME /opt/oracle/product/7.1.4`)
- Make Sure: ORACLE_SID points to the nidas database.
  (ex: `setenv ORACLE_SID nidas`)
- Add: `setenv ORA_NIDAS_SW /usr/people/nidas/ONIDAS_SW`
  This environment variable points to the NIDAS–C software directory. It will be used by the software.
- Add: `setenv ORA_NEONS_SW $ORA_NIDAS_SW/oneons_sw`
  This environment variable points to NEONS software.
- Add: `setenv ORA_NIDASC_EXP ~`
  This environment variable points to a directory that you, as a user, have write permission. This directory is for the export files to be exported to. In the directory specified by this variable there should be another directory named `nc_export`. This is the directory that NIDAS–C puts the export files.
- Add: `setenv DBA nidas`
  This environment variable points to the nidas dba account that you are installing NIDAS–C under. This has to be a real user that owns the software.
- Add: `setenv XAPPLRESDIR ~/app-defaults`
  This environment variable points to your application default resource directory. If you do not have this directory in your home directory, it must be created.
- Add: `set path = ($path $ORACLE_HOME/bin $ORA_NIDAS_SW/bin)`
  This adds the NIDAS–C executable directory and the Oracle executable directory to your path. If you do not have a path to begin with, take "$path" out of this command.
- Add: `source $ORACLE_HOME/bin/oraenv`
  This brings in the rest of the ORACLE environment.

Importing the Database

Change the current directory to `$ORA_NIDAS_SW` (cd `$ORA_NIDAS_SW`) and execute `INSTALL`. This is simple script that will ask a few questions and then compile the software.

- You will be asked if you want to clean, clobber, or install the software. Answer no to the clean and clobber by typing `n` followed by the `<return>` key. Then answer yes to the install by typing `y` followed by the `<return>` key.
Appendix C

Then you will be asked if you want to install the nidas database. Answer yes to this question by typing y followed by the <return> key. This executes olin-port_db which uncompresses the import file, imports the database into oracle, and compresses the import file. This step can be done manually by executing olinport_db. This step also compiles some data utilities. This can be done manually by changing to the $ORA_NIDAS_SW/sample_data/n_utilities (cd $ORA_NIDAS_SW/sample_data/n_utilities) and executing the command make -f make.MACHINE where MACHINE is either sun, sol, sgi4, or sgi5.

Installing the Software

Refer to Importing the Database for installing the data utilities.

Then you will be asked if you want to install the NEONS software. Answer yes to this question by typing y followed by the <return> key. This can done manually by changing to the $ORA_NEONS_SW/libsrc/db_io, $ORA_NEONS_SW/libsrc/db_util, and $ORA_NEONS_SW/libsrc/nidas_io directories and executing make -f make.MACHINE install where MACHINE is either sun, sol, sgi4, or sgi5.

Then you will be asked if you want to install the NIDAS-C software. Answer yes to this question by typing y followed by the <return> key. This can done manually by changing to the $ORA_NIDAS_SW/onidacs-clsrc directory and executing make -f make.MACHINE install where MACHINE is either sun, sol, sgi4, or sgi5. Then changing to the $ORA_NIDAS_SW/onidacs-cidba directory and executing make.MACHINE install where MACHINE is either sun, sol, sgi4, or sgi5.

Clean-Up

You need to copy the "app-defaults" files to your app-defaults directory. You can do this by executing the command cp $ORA_NIDAS_SW/app-defaults/* $XAPPLRESDIR/.

If you are installing NIDAS-C on a SGI, you need to copy the "app-defaults" file to the system app-defaults directory. This has to be done by the system administrator logged in as root. As root, execute cp $ORA_NIDAS_SW/app-defaults/* /usr/lib/X11/app-defaults/.

Remarks

Some sample data has been provided for ingestion. This data is located in the $ORA_NIDAS_SW/sample_data directory as moods and n_testdata.

The executables that are provided and created are as follows:

• nidas-c – Nidas Climatology
• nidas-c_dba – DbaTools for Nidas Climatology
• nidas-c_ltt_wr – Ingest routine for Nidas Climatology
Appendix C

- **split-b** – Splits data (master format) into Temperature and Salinity
- **chrtr8** – Interpolates grid into chrtr format
- **chrtrout** – Reads bathy data (chrtr format) and makes ascii file for viewing
- **binmaster** – Subsets a master format file by location, month, instrument, and/or bottom depth
- **dumpheader** – Reads llt data and makes ascii file of header only
- **dumpm** – Reads llt data and makes ascii file for viewing
- **fatfinger** – Reads ascii file of llt profiles created manually by a user and converts to master format
- **imakemaster** – Converts MOODS admin format to master “B” file format for Nidas ingest
- **lclimfacs** – Reads volume data (3-D climatology and model grids) and lists pertinent information
- **provprof-master** – Reads Nidas export file for “synthetic” profiles and converts to master format
- **filefacs** – Reads llt data (master format) and lists pertinent information about the data set
DISTRIBUTION LIST

1. Commanding Officer, Code N3211
   Naval Oceanographic Office
   Stennis Space Center, MS 39529

2. Technical Director
   Code OOT
   COMNAVMETOCOM
   Stennis Space Center, MS 39529

3. Oceanographer of the Navy
   U.S. Naval Observatory
   34th and Massachusetts Avenue
   Washington, DC 20392

4. Space and Naval Warfare
   Systems Command
   Code PMW175-3B
   2451 Crystal Drive
   Arlington, VA 2245-6145

5. Defense Technical Information Center
   Building 5, Cameron Station
   Alexandria VA 22304-6145

6. Director, Sponsored Programs Administration
   Mississippi State University
   Mississippi State, MS 39762
**Title and Subtitle:**

USER'S MANUAL FOR THE NAVAL INTERACTIVE DATA ANALYSIS SYSTEM - CLIMATOLOGIES (NIDAS-C) VERSION 2.0

**Performing Organization:**

MISSISSIPPI STATE UNIVERSITY CENTER FOR AIR SEA TECHNOLOGY STENNIS SPACE CENTER, MS 39529

**Sponsoring/Monitoring Agency:**

NAVAL OCEANOGRAPHIC OFFICE CODE DOST STENNIS SPACE CENTER, MS 39529

**Alternate Title:**

RESEARCH PERFORMED UNDER NRI CONTRACT NO0014-92-C-6032 MOD P00009 AND NASA NAS-13-564 DELIVERY ORDER 82

**Abstract:**

THIS TECHNICAL NOTE PROVIDES THE USER'S MANUAL FOR THE NIDAS-C SYSTEM DEVELOPED FOR THE NAVAL OCEANOGRAPHIC OFFICE.